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CoreIDRAW SE

CorelDRAW SE is part of BERNINA Embroidery Software and gives users
many tools for creating high quality vector illustrations that can be convert-
ed to embroidery. In addition, the program offers additional opportunities
for creating printed materials and for editing photos.

There are three components included with Corel: CorelDRAW SE, Corel
PHOTO-PAINT SE, and Corel CONNECT. This eBook will focus on the
first component of Corel.

HINTS

When a tool is selected in CoreIDRAW SE, hints will help you learn how to
use the selected tool. If you need additional information about the selected
tool, you can click on Learn More in the upper-right corner of the Hints
docker and you are given more choices for additional information. Click on
the title to the right of the question mark or other symbol and you will be
taken to a page in the manual, videos, webinars, or tutorials that relate to
that topic. To access videos, webinars, and tutorials, an Internet connec-
tion is required.

In addition, you can use the back and forth buttons in the lower right corner
of the Hints docker box to scroll through more information.

VIDEOS

You can access videos, webinars, and tutorials by selecting Help> Video
Tutorials. An Internet connection is required to view these.

Just click on the list of options and select the video you wish to see. This
will link with YouTube.

Corel Video Tutorials
What's New in CorelDRAW...
CorelDRAW® Video Hints
Basic Shapes
Basic Transformations
Fills and Outlines
Adding Text
Linking Text Frames
Drawing Curves
Shaping Curves
Node Editing
Smart Fills

Watch on YouTube

Flash-embedded videos are no longer supported,

Interactive Contour

Interactive Transparency

but you can still watch this video on YouTube.

Interactive Drop Shadow
Interactive Fill
Interactive Envelope WATCH ON YOUTUBE

Interactive Blend

Sampling Colors

Virtual Segment Delete
Corel® PHOTO-PAINT™ Vi...
What was New in Version X7
Training Videos and Webinars
ome features shown in the video
orials are only available in
relDRAW® Graphics Suite X8.

Visit the Discovery Center for
more learning resources
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Notes:

If the Hint Docker is not visi-
ble, go to Window> Dockers
and make sure there is a
check mark by Hints.

Leam
more

HINTS

Welcome to Hints!

To display topics, click a toel, or perform an
action with a tool. For additional
information about the active tool, click the
Help button in the upper-right corner of the
Hints docker.

Here are some particularly helpful topics:
= Drawing lines

» Drawing connector lines

* Drawing dimension lines

= Drawing shapes

» Selecting cbjects

= Moving, scaling, and stretching objects
= Rotating and skewing objects

= Shaping objects

= Applying special effects to objects

= Qutlining objects

« Filling objects

= Adding text

= Getting help

Learn more

?

CorelDRAW Help

= Help topic

u Corel Video Tutorials
'~ What's New in CoreIDRAW®...
. Support for Windows 10
Working with curves
I CoreDRAW® Video Hints
I Corel® PHOTO-PAINT™ Video...
b What was New in Version X7
B Trnlg Videos .'md Webinars
b Maore videus
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BERNINA Embroidery Software DesignerPlus - [Design1 (Corel)] TITLE BAR - X
File Edit View Layout Object Effects Bitmaps Text Table Tools Window Help MENU BAR
‘ ﬁ . CANVAS TOOLBAR
N5 FETpE G o [~ m I B S G [ touncn ~ GENERAL TOOLBAR
Q & Lot - E ffn “C 0O S Do units|inches - @fom |2 gj gsz = ([ PROPERTY TOOLBAR
u 3 1 RULERS 1 ¢ i 4 3 i T g $ 1 = Hints DOCKERS
O |9f - =
%, B
D. | Drawing rectangles b
+
AR [ ]Rectangle tecl =
A +To draw 2 rectangle, drag where you want =
to place it. =
L4 DRAWING PAGE 3
W
L] =
Z, = =z
0 Holding down Ctrl draws a square, while 2
4 holding down Shift draws from the center. =
f“ +To change the rectangle’s shape, click the E
TDOLBOX ettty )
] See Moving, scaling, and stretching objects
or Rotating and skewing objects for
information on transfarming this object.
u brochure template o ‘[
v
& 1of 1 & | Pagel f e NAVIAGATOR o Video
v DOCUMENT k & A
(6024,-4128) » HAd=7E STATUS BAR &)X None 4 [l como vokioo 0s00pt

o Title Bar: Located at the top of the screen, this bar displays the title of the current file.

e Menu Bar: This area contains the pull-down menu options.

e Canvas Toolbar: These icons are used to change to Embroidery Canvas, hide the em-
broidery, or convert a picture into stitches.

e General Toolbar: These icons perform general commands.

o Property Bar: These icons relate to the active tool or object. This bar changes with
each tool selected.

e Rulers: Horizontal and vertical rulers can be used to determine the position and size
of the objects in the drawing.

e Toolbox: The two columns of tools are used for creating and modifying the objects
on the drawing page.

o Drawing Page: The drawing page shows you the printable area of the design.

e Document Palette: This area will show the colors that are used in the drawing.

o Status Bar: Located at the bottom of the screen, the status bar will display infor-
mation about the properties of the design as well as the position coordinates.

o Dockers: This window on the right side of the screen includes commands and set-
tings relevant to the specific tool. Dockers are displayed by going to Window> Dockers and
checking the ones you wish to display. The inactive Dockers appear as tabs on the side of
the window.

o Navigator: The button at the lower right hand corner of the Drawing Page opens a
smaller display to help you move around the Drawing Page. To see the smaller display, click

QX Mone and hold on the icon.
o Color Palette: A dockable bar that contains color swatches. A right click on the color
& . | chip affects the outline; while a left click affects the fill of a selected object. The current col-
ors of the fill and outline are shown in the status bar at the far right.
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WORKSPACE TOOLS

Commands are accessible through the menu bar, toolbars, property bar, and dockers. The
property bar and dockers relate to the active tool. Not all the tools are active.

Q4 Py By Ry S Cov B [0 [oox || S EE[° & F) Lounch ~

TOOLBAR

New: This tool is not active in Artwork Canvas.

Open: This tool is not active in Artwork Canvas.

Save: This tool is not active in Artwork Canvas.

Print: This will print what is displayed in the Drawing Page.

Cut: Cuts the selected objects to the Clipboard.

Copy: Copies the selected objects to the Clipboard.

Paste: Pastes the Clipboard contents to the drawing.

Undo: Used to undo an action.

Redo: Restores the action that was undone.

Search Content: Displays the Connect docker so that you can search for clipart, photos,
fonts.

Import: Imports a drawing.

Export: Exports a drawing.

Publish to PDF: Exports the document in PDF format.

Zoom Levels: Use this to specify a zoom level.

Full Screen Preview: Use this to show the drawing in full screen. Click on the screen to
return to Artwork Canvas.

Show Rulers: This tool will show or hide the rulers.

Show Grid: This will show or hide the grid.

Show Guidelines: This will show or hide the guidelines.

Snap To: This tool is not active in Artwork Canvas.

Options: This opens a dialog box so that you can set options for Artwork Canvas.
Application Launcher: This will launch Corel applications that you choose from a drop-
down menu.

TOOLBOX h'lb% A

The toolbox contains tools for drawing and editing images. Some of the tools are always visi-
ble, while others are grouped together in flyouts. Flyouts open by clicking and holding your cur-
sor on the visible icon to show the set of related CoreIDRAW tools. The flyout toolbars can be
moved from the toolbox by clicking and dragging on the title bar. Clicking on the X in the upper
right hand corner returns the flyout to its original position. Once another tool is selected from
the flyout menu, the default tool is replaced by the new tool selected.

\ Pick: This tool lets you select objects that can then be sized, skewed, and rotated.

Zoom: You can zoom in or out of the drawing page by left clicking (zooms in) or by right
clicking (zooms out). In addition, you can draw a bounding box around any area of the design
to zoom in. F4 is the short cut key to show all of the design.

O

Pan: Housed with the Zoom tool, the Pan tool allows you to move the design on the
'@] screen without changing the level of the zoom or the position of the object.

2018 © BERNINA Page 4
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TOOLBOX CONTINUED Notes:

Reshape Vector Object: This tool lets you edit the shape of objects ‘
by clicking and dragging on a node or on the control handles (arrows that X
+

appear when a node is selected on objects converted to curves). \ /

?:-..

Freehand Draw: This tool is used to draw single line segments and
curves by clicking and dragging on the screen. Yaan

Artistic Media: This tool gives you access to the Brush, Sprayer, Cal- S
ligraphic, and Pressure tools. These create special effects that sometimes

can be converted into embroidery. ﬁ

Pen: This tool lets you draw lines one segment at a time. A straight

G| |

the Ctrl key and click and drag. Release your mouse before you release
the Ctrl key. l«.

0 line can be drawn by clicking, releasing your mouse, and dragging to a = = o
new area to click again. To draw a curved line, click and drag your mouse . _\@
without releasing it, click again. Press the space bar to end the line. /X

H-'h Smart Drawing: This tool converts lines and shapes to smoother R, P
lines and shapes when the mouse is released. \ V7 /
Rectangle: This tool creates rectangles and squares. To draw a y
square, hold the Ctrl key and click and drag. Release your mouse before
you release the Cirl key. D
Ellipse: This tool draws ellipses and circles. To draw a circle, hold —

Polygon: The Polygon tool lets you draw polygons. You select the
number of sides for your shape in the Property Bar. e

Star: The star tool will draw stars.

Graph Paper: This tool will draw a grid of lines similar to those found
on graph paper. You can adjust the number of vertical and horizontal lines.

@ B [0 [0] O

Spiral: The Spiral tool lets you draw symmetrical and logarithmic spi-
rals. @ AR =)
= RFN e
Basic Vector Shapes: The Basic Shapes tool lets you choose from A VN O g
y several shapes, including a smiley face, a right triangle, and a heart.

. Plaafei$
= Arrow Shapes: The Arrow shapes tool draws arrows of various SaaDDD
&= | shapes, direction, and number of arrows.

AP S Qo
3% [ Banner Shapes: The Banner tool draws ribbon objects and explosion
M | shapes. ) x 0 £3 33
Q Callout Shapes: This tool can be used to draw callouts. f;j =
B.o4a
2018 © BERNINA Page 5
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TOOLBOX CONTINUED Notes:

ther as artistic or paragraph text.

Crop Bitmap Artwork: The Crop tool lets you remove unwanted areas
in objects by drawing a bounding box around the area you wish to keep
and double clicking.

IEI Vector Lettering Tool: Words can be typed directly on the screen ei-

Knife: The knife tool splits an object with a straight, curved, or free-
hand line.

rﬂ:‘ Segment Tool: This tool will delete single or multiple line segments.

Erase Tool: The Erase tool removes areas of your drawing by drag-
ging across the unwanted areas. You can adjust the size and the shape of
the eraser. To erase a straight line through an object, click to the outside of
the object, hold the Shift key down, and drag across the object, and click
again.

Theses next tools are part of the Interactive Tool Flyout:

Blend Vector Object: The Blend tool lets you blend two objects. Both
[i the shape and the color can be blended and either a straight path or
curved path can be applied. To create a curved path, hold the Alt key as
you draw from one object to another.

B Contour Tool: This tool will add layers of color to an object. An out-
side or inside contour can be added. The number of layers and the offset
(affects the sizes of the layers) can also be adjusted.

Distort Tool: With this tool, a Push or Pull distortion, a Zipper distor-
tion, or a Twister distortion can be applied to an object.

Envelope Tool: This tool lets you shape an object by
K dragging the nodes of the envelope. It is similar to the
Morphing tool in the Embroidery Canvas.

‘ Extrude Tool: This tool lets you apply the illusion of depth to objects.

Interactive Foundation Fill: This tool lets you apply various types of

fills to an object. You can quickly access the dialog boxes for the various fill
A‘ types by clicking on the Fill icon (paint bucket), the last icon in the first col-
umn of tools.

2018 © BERNINA Page 6
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TOOLBOX CONTINUED

The second column of tools in the Toolbox contains icons that access dif-
ferent functions of Artwork Canvas.

Insert Artwork: This icon is used to import either bitmap or vector
artwork into Artwork Canvas.

Scan Bitmap: This icon lets you scan directly into Artwork Canvas
from a TWAIN-compatible scanner.

Edit Bitmap: This icon loads a bitmap image into Corel PHOTO-
PAINT. The bitmap can be then be edited.

Save Artwork: This icon will open a dialog box so that an adjusted or
created image can be saved in several types of formats.

PROPERTY BARS

The Property Bar is interactive; in other words, it changes with each new
icon selected. Let’s look next at the Property bars for each of the tools in
the Toolbox to learn about what each icon has available.

Pick Property Bar
When this tool is selected, but nothing is selected on the drawing page,
the Property Bar shows these icons:

Notes:

Some of the Property Bars
have been divided in half so
the icons will be larger.

page to know if the design will fit within a certain size. If you wish to hide
the page border, go to View> Page and uncheck Page Border.

Portrait/Landscape: You can choose between portrait and landscape
orientation for your paper size.

All Pages/Current Page: The first icon applies the page size to all
pages; the second icon applies the page size to only the current page.

Drawing Units: You can choose among many measurement methods.

Nudge Distance: This sets the amount a design will move when us-
ing the arrow keys.

Duplicate Distance: When you duplicate an object, you can specify
the distance between the original and the duplicate for the X and Y axes.

Treat All Objects As Filled: Allows unfilled objects to be selected by
clicking inside the object.

Quick Customize: Customize the Toolbar by selecting what you wish
to view from the list.

2018 © BERNINA

Letter - %Eﬁg" D ] % |]u|:| Units: | inches w |  ale 007" &: Eig: :: ]:&
Page Size: This tool lets you choose a page size for the document.
[ et ——
Page Dimensions: You can change the width and the height of the _.__@
milmeters

picas, points
points

pixels
ciceros, didots
didots

feet

yards

miles
centimeters
meters
kilorneters

Q

If you do customize the
toolbar, you can reset by click-
ing this icon as well and then
select, Reset Toolbar.

Page 7
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TOOLBOX CONTINUED

Notes:

Drop Shadow: This tool applies a shadow to an object. This is an ef-
fect that cannot be converted to embroidery.

Transparency: This tool applies transparencies to objects. It is an-
other effect that cannot be converted to embroidery.

an object in the drawing window.

Apply Color: The Apply Color tool applies the selected color to an
object.

/ Pick Color: The Pick Color tool lets you select and copy a color from

These tools are part of the Outline Flyout: 0 15 R ———

Outline Pen: Initially, this tool opens a dialog box that notifies you
el that you will change the default object properties created in the current
drawing. You may check to not show this dialog again if you wish. After
clicking OK, select the options you wish to use for the document, such as
outline thickness, corner shape, and arrow type.

\ Outline Color: This icon opens a dialog box so that a new color can
o be chosen from the dialog box.

Outline Properties: This series of icons let you change the thickness X % —_— e — -
of the outline.

=+—| Color Docker Window: This icon is in both the Outline and the Fill = o

——| Flyout. It opens the Color Docker window so that you can choose a new = s

color for the outline or the fill by clicking on the appropriate button.

These tools are part of the Fill Flyout:

Uniform Fill: This icon opens the Uniform Fill dialog box. You can
. change the color of the fill in this dialog box to one color. Only the Uniform
Fill converts to embroidery.

Fountain Fill: This icon opens the Fountain Fill dialog box and is
[ used to impart two-color fills. The type of Fountain Fill can be chosen from
Linear, Radial, Conical, or Square.

Pattern Fill: This icon opens the Pattern Fill dialog box and you can
choose among several built-in patterns. In addition, you can create your
own pattern. While these patterns do not convert to embroidery, they can
be used for printing and also as backgrounds for digitizing.

Texture Fill: This tool opens the Texture Fill dialog box and you can
choose among several textures. In addition, different colors can be applied
to the various textures.

2018 © BERNINA Page 8
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PROPERTY BARS:
If an object or bitmap image is selected: Notes:

o . . . . . If you wish to change the size
This first group of icons will be displayed when objects or bit- Of};-he object: ,fLogk Ratio is
maps are selected. unlocked, you can change ei-

S TE o =7 ther the Width or the Height

g g : b 0.0 O ma E independently of the other. If

g il5247 1000 |% © s Lock Ratio is locked, changing

. - . e the width will ch th
Object Origin: Set the Reference Point to use when positioning hee,-gV,:'t p,ovgloﬂioﬁgﬁforiice

or scaling the object. Click on the spot on the icon to set.

versa.

Object Position: Shows the position of the object on X & Y axis.
Object Size: Shows the object size in the selected unit of measure-  pPiect Manager
ment. 5= W9 E:f:r11 g
Scale Factor: You can resize an object specifying a percentage. =0 ngi.- s

: . . B @®@dh Layer 1
chk Ratio: .If Iocked, both dimensions are changed proportionally by 5¢5
either a specified size or by percentage. I & apple heart 002.jpg
Angle of Rotation: Rotate a selected object by a certain degree. The Bitmap is listed as a jpg in
Mirror Horizontally: Mirrors an object left/right. this example; the Vector is the
Mirror Vertically: Mirrors an object up/down. group of 158 Objects. To de-

lete the Bitmap, click on it and

This group of icons appear when a bitmap is selected: press Delete.

F : < i e - E
L Edit Bitrnap... L Trace Bitmap @ I:I = G;h E Trace Bitmap =
Edit Bitmap: Opens the bitmap in Corel PHOTO-PAINT. [ Quick Trace
. . . . Centerline Trace 3
Trace Bitmap: Creates a vector image from the bitmap image. There _
are several methods to accomplish this. Outline Trace 4

After tracing, the bitmap has to be deleted to get rid of it entirely. Use Ob-
ject Manager Docker to delete the bitmap. To open Object Manager,goto . i
Window> Dockers and make sure a check mark is placed by Object Man- C’;,a,f;: ?Z,g ’%’;gg”s,iae”o, res-

ager. olution or both. If you make an
image larger without changing
Crop Bitmap: Inactive icon, but the Crop icon in the Toolbox can be the resolution, the image may
used. lose detail because the num-
ber of pixels cover a larger

Resample Bitmap: Opens a dialog box where an image size and reso- | @¢a. By Resampling, you may
lution can be changed. add pixels to preserve the de-

tail. Resizing an image will
maintain the same number of
pixels in the new area.

Upsampling adds pixels.
Downsampling decreases the
resolution of a bitmap.

2018 © BERNINA Page 9
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Bitmap Color Mask: Opens the Bitmap Color Mask Docker.

Wrap Text: Choose a style for wrapping paragraph text around an
image.

Select the bitmap, click on the icon to choose your style for wrapping, se-
lect the Vector Lettering icon and click and drag around the bitmap. Make
sure the box that you draw is larger than the bitmap. Text boxes will ap-
pear for the wrapping style you chose.

To Front of Layer: Move the selected object to the front of the layer.
To Back of Layer: Move the selected object to the back of the layers.
Quick Customize: Customize the Toolbar by selecting what you wish

to view from the list.

The group of icons that appear when a vector object is selected
will depend on whether one object or a group of objects have
been selected:

If one object is selected:
The icons that appear in the Property Bar depend on what tool was used to
create the object.

If more than one object is selected:
Additional icons appear when more than one object is selected on screen.

OO0 mad-e,.’—b maE BERNINA

Notes:

Wrap Text:

T

W O hEEaE W § B | = =

Combine: This combines objects into a single object with common
properties. A combined object can be broken apart. The combination takes
on the properties of the last selected object.

Weld: Weld combines the two shapes and the last one selected will
be the one that dictates the properties of the other.

Trim: With Trim, one object cuts the other object. The last one select-
ed will be the object that is trimmed.

Intersect: Intersect forms a new object from the overlapping of multi-

ple objects. The new object takes on the properties of the last selected ob-
ject.

2018 © BERNINA
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Multiple Objects Selected cont. Notes:

8
i
i
|
A
|
Bl
==
4

1}

ij

Simplify: Simplify trims overlapping areas among objects.

Front Minus Back: Removes the back object from the front.

Back Minus Front: Removes the front object from the back.
These both differ from Trim because with Trim, you still have both objects;
one will be trimmed, but the other remains.

Create a Boundary: Creates a new object that surrounds the selected
objects.

Outline Width: Change the width of an outlined object.

Group: Group preserves the attributes of the objects, but treats the

i F it
grouped objects as a unit. inus Fron

o et

Ungroup Objects: Break a group of objects into individual objects.

Ungroup All Objects: If two grouped objects are grouped with anoth-
er object, Ungroup All will make each of the objects individual objects.

Create a
Boundary
Align & Distribute: Opens the Align & Distribute Docker. You can
align and space horizontally, vertically, to the left, center, or right.
Align and Distribute
Align Distribute
5 W = P fi g8 3f
T & b o = % &
2018 © BERNINA Page 11
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Zoom Property Bar Notes:
Q These are the icons displayed when Zoom is the selected tool. =
3%
73% - & Q (4 T la To Fit
To Selected
Zoom Level: You can specify your level of zoom by selecting one of To Page
the selections from the drop-down menu or by highlighting the amount and | [Te Width
entering a new amount. Pressing Enter activates the change. i el
Zoom In: Click this icon to zoom into the page. mj
Zoom Out: Click this icon to zoom out from the page. ig;
Zoom to Selected: This icon is only highlighted when an object is ;g;ﬁﬁj
selected. 300%
Zoom to All Objects: This icon lets you see all objects on the draw- A00%
ing page. 800%
Zoom to Page; Zoom to Page Width; Zoom to Page Height: These 1600%
icons are nonfunctional.
Quick Customize: See page 7.
@ Pan: When pan is selected, the icons in the Property Bar are the
zoom icons.
Shapes Tools Property Bar
This Property Bar is displayed if the tool is selected or if the object drawn
with that tool is selected. The first part of the bar is the same as when a
picture is selected and appears for all the shape tools except Graph and
Spiral Tools. See page 9.
The middle part of the bar changes with the type of object that is selected
or which type of shape tool is selected.
X|-1.25" (4.5 " 1000 |% ol na @
EE Nl 25" 25" 100.0 | % o O sk Cd & F Y
Rectangle Property Bar
; : 00" - «f oo B L
(1) &1 1 g -0 4] Tloo" -all 7 I
A g
Round Corner: By selecting this; then using the up arrows next to
the appropriate corner, you can round the corners of a square or rectangle.
Scallop Corner: This icon changes the corner to a scallop.
. . \\I—[{f_
Chamfered Corner: This icon changes the corner to a flat edge.
Corner Radius: When locked, all corners will be changed. When un-
locked, each corner can be changed independently of the others.
Relative Corner Scaling: Scale the corners relative to the size of the
rectangle. \ /
2018 © BERNINA Page 12
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Ellipse Property Bar (%(90.0° |+ = =
O oG C = .0 |~ = Notes: y' \
i .\
/
Ellipse: When this shape is activated with the Ellipse tool, an oval or \\5 >
circle will be drawn. It is the default shape for the Ellipse tool. =

will be drawn. If an oval or circle or arc is selected; then this icon is activat-

Pie: When this shape is activated with the Ellipse tool, a pie shape L' J—A
ed, the shape will change to a pie shape. \

Arc: When this shape is activated with the Ellipse tool, an arc shape f ‘\'\;
will be drawn. If an oval or circle or pie shape is selected; then this icon is \

activated, the shape will change to an arc shape. Mo .
Starting & Ending Angles: These values can be manipulated to get {/“’ﬁ_—ﬂ“‘x

different shapes for arcs and pie shapes. L A /
Change Direction: This creates the missing piece (the opposite from

the original) of the pie or arc shape. T

Polygon Property Bar | CO5 - —

o You can specify the number of points or sides of the polygon. You can
specify the number either before or after you draw the shape.

A
I\ \ Y V4
- - - -
Stars Property Bar wis o] A% |- :Z b E
-

jf_"{ Points or Sides: Sets the number of points or sides of the star.

Sharpness: Adjusts the corner sharpness of the star. A \/\/
The end of the Property Bar for the Shapes Tools: ~ ? : Ty _
! 4 i
3 IEIEENEE P PN

Outline Width: Adjusts the width of the outline around an object.
Hairline, .5, .75, and 1 point will convert to a single outline in embroidery.
Other widths will convert to a satin fill.

& ] i

Wrap Text: See page 10. Mone
Front of Layer: Sends the selected object g-;;tt
of a stack of objects to the front of the stack. 10 pﬁ
Back of Layer: Sends the selected object 1.5pt
of a stack of objects to the back of the layer. 2.0pt
3.0pt

Convert to Curves: Changes the drawn shape to an object that has g'g EE
control handles and nodes. You can manipulate the nodes and control 10.0 pt
handles to change the object’s shape. 12.0 pt
16.0 pt
. o 24.0 pt
Quick Customize: See page 7. gzl

2018 © BERNINA Page 13
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@ Graph Paper Property Bar Notes:
E‘;’ — dlospt  |v| | ——~ =,

Columns & Rows: Specify the number of rows and columns in your
graph. Values must be specified before drawing the graph. This will con-

vert to embroidery.

Outline Width: See page 11.

Line Style: Choose from various built-in types of lines. When you click
on More, a dialog box opens and you can edit a selected line. — 7]

[«
Edit Line Style === >< ‘_

Glick on the squares to tun dots in the line style on and off:

e
) [

Hint:  The firstdotin the line style must be black, and the
last dot must be a space. You can adjust the end of
the line style by moving the bar on the right side of

2 Ine. There is a Imit of 5 dashes per outine style.

Close Curve: Join or detach the end nodes of the curve.  §{ [|F-—mm-
Wrap Text: See page 10.
Quick Customize: See page 7.

@) Spiral Property Bar — =
e+ [ [el® lo/m 3D o R b f— =)
Spiral Revolutions: Set the number of full circle revolutions in the — =
spiral. 2T / fa—x X
I|' I- L/C—x_\} : | I |' |I ~ | | |

Symmetric Spiral: Spiral has even revolutions. S ety B A WL
Logarithmic Spiral: Spiral has tighter revolutions in the center. ‘\:u:-{f ¥ #//’
Spiral Expansion Factor: Changes the rate that the spiral changes as
it is drawn. A higher number places the revolutions further apart. This is S
only active for Logarithmic spirals. R o \

I‘_r /.-'-_\;..\‘ .\II | l |:-'€\|| I| I
Outline Width: Changes the size of the outline. 'g. {\ o / |'.\ e S

A" R s 5,

e - ' g
Start Arrowhead: Choose the way the line starts. You can add an ar- TR S~—
rowhead to the beginning of a drawn line or preselect it; then draw the line.
Use the scroll bar to find even more shapes. "

— <« <€ <«
Line Style: Choose among solid and dotted variations.
End Arrowhead: Choose the way the line ends. 4 H— «— @«
Close Curve: This will join the end nodes of the curve.
Wrap Text: See page 10. « 4= B> —
Quick Customize: See page 7. v
2018 © BERNINA Page 14
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Perfect Shapes Property Bar

The first part of the Property Bar is the same as when a picture or object
shape is selected.

%[-05" | 0,5 " 1000 [% ;
O | n
V(275" flo5" 1000 % @ L]0 Gl

Object Origin
Object Position
Object Size

Scale Factor

Lock Ratio

Angle of Rotation
Mirror Horizontally
Mirror Vertically

The last part of the Property Bar is the same as when an object shape is
selected.

3 R

Outline Width
Wrap Text

To Front of Layer
To Back of Layer
Quick Customize

The only part that is different is the middle section. The middle section will
change based on which vector shape is selected, but the tool shown will
function the same—it allows you to select the type of shape.

Perfect Shape: Click on this icon to select from an assortment of

shapes to draw. Just drag your cursor to select the desired shape. Click
and drag to draw the shape.

2018 © BERNINA

Notes:
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Curve Flyouts Property Bar 'tz,,_ ]é) 0 gt».‘ Notes:

For the Freehand Draw Tool and the Pen Tool, the first part of the Property
Bar is the same as for Shapes Tools.

®[-0953" W+ (0,409 " 100.0 [% :
] iy .2
E:E ¥:[2.148 " floa" 100.0 [% CRRSIL Bl i

1}*- Freehand Draw Property Bar
b ¢ |- - — = 7| Y ~so 4L

Break Apart: This icon is not active unless two objects have been
combined; then selected.

Outline Width: See page 11.

Start Arrowhead: See page 14.

Line Style: See page 14.
End Arrowhead: See page 14.
Close Curve: Join the ends of the nodes so that aline creates an

enclosed shape.

Wrap Text: See page 10.
v | 539 &

Freehand Smoothing: Adjusts the smoothness of the Freehand Draw ; | .
tool. A higher number creates fewer nodes as you draw a line. b fevaibnh It}
Bounding Box: When activated, the black selection boxes are hidden n n n
when you draw with the Freehand tool. B\
Quick Customize: See page 7. [ \-

| | |

0 Pen Tool Property Bar
The Pen Tool shares the same Arrowhead and Line Style Lines, as well as
Close Curve, Outline Width, Wrap Text, Bounding Box, and Quick Custom-
ize.
8 SR I R | — e P
The two new icons specific to the Pen Tool are: -~ @us
aj|gs Previewing
a line "

Preview Mode: Preview Mode lets you see the line segment as you
are drawing it. When it is off, the line is drawn without a preview.
Automatically Add or Delete Nodes: After thelineis drawn, you can " 4
use this icon to add or delete nodes. If the icon is highlighted, point to an
existing node and click and it will be deleted or click on the line to add a
node. ]

__Auto"Add
These tools are found in the middle of the Property Bar. sfge

* ..h“-\\
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Artistic Media Notes:
The Property Bar changes depending on the type of Artistic Media you
have selected. There are five types of Artistic Media.

b 4 A 4 & wi,

)

e Preset: You can draw a curve choosing among various presets. @fﬁek

e Brush: Draw a curve that resembles a paint brush stroke. e

o Spray: Draw by spraying a set of preset images.

o Calligraphic: Draw a curve that resembles a calligraphy pen ﬂ
stroke.

» Pressure: Mimic the effect of drawing with a pressure sensitive ﬂ

pen. This is for using with a tablet.

bd Preset Property Bar

S o AN AL G T 1L e R W] - ’\/

-

Preset Stroke List: Choose from many different

types of preset strokes.

Freehand Smoothing: See page 16.

Stroke Width: This icon adjusts the stroke width.

Scale Stroke With Object: Activate this when /\

7\
v
rescaling an object so that the width of the line will
change proportionally. ’\-/
¥

Bounding Box: See page 16.
Quick Customize: See page 7.

o g

i Brush Property Bar e
Artistic v | e v P ~00 || @05t ||
Category: Choose a category; then choose from an assort- | Aistic == v E
ment of brush types. Have fun creating! These do convert to em- || [ Artistic
broidery, but some editing may be necessary. § Calligraphy - EEE

Brush Stroke: Choose the type of brush stroke from a drop- | 4 gpjects
down menu. All sorts of fun objects are included that convert to & Scroll

embkroidery. You can also create your own customized brush foeta o 'Y R X LEXEE
strokes. i Splatter

&3 Symbaol
Browse: Used to browse to your custom strokes.

Save: Used to save custom strokes.

U Texture

Delete: Used to delete custom strokes. —‘—‘
Freehand Smoothing: See page 16. @eg& T
Stroke Width: See information in Preset Property Bar. >
Scale Stroke With Object: See information in Preset Proper- —

"
ty Bar. =
Bounding Box: See page 16. @
Quick Customize: See page 7.
2018 © BERNINA : Page 17
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i Spray Property Bar Notes:

The Spray Property Bar is shown in two parts.

Erush Strokes - St - D i

& ..
Brush Strokes g <
Category: Choose a category; then choose among :lv

the options in the spray list. These do convert to embroi- | gl E;L:dh Aipkes
dery, but will usually need some editing.

Spray Pattern: Choose from the drop-down menu. g? Ej'i'::pri"t L e J
Browse: Used to browse sprays. ™ Mosaic
Save: Sprays can be created and saved; then deleted. £% Music g =
Delete: Used to delete custom sprays. §® Objects i “
Spray List Options: Used to edit the spray list. You &0 Plants
can add, delete, or rearrange the objects. i Splatter I Tl
" Stars

f100) > « % — a* 1 e g

29 4 | Sequenti... =10 |f].::" .?n‘ s 222050 5
Size of sprayed objects:

The upper box resizes objects uniformly as percentage of their original F* “ﬂf«r""fﬂ
size. The lower box resizes each object as a percentage of the preceding

object.
e @ O@
Incremental Spraying: Must be in the locked position to change the 2

size of the lower box. f\’\©
Sequentially /;
Spray Order: Sprays can be arranged randomly, sequentially, or by =

direction. _ o . . By Direction
Add to Spray List: After a new object is created, if selected, it can be

added to a spray list.

Spray List Options: After a spray is created, it can be edited by click-

ing on this icon. You can add, remove, or rearrange. A dialog box opens up @O@
to assist you in editing.

Images per Dab & Image Spacing:

The upper box sets the number of images per dab.

The lower box adjusts the distance between dabs along the length of each
stroke.

Rotation: You can rotate the objects within the Spray. ama E e

Offset: You can offset the objects within the Spray and select differ-
ent types of patterns; alternating, left, right, and random. G

Scale Stroke with Object: See page 17.
Bounding Box: See page 16. D

Quick Customize: See page 7. D m
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Calligraphic Property Bar

Freehand Smoothing: See page 16.

Stroke Width: See page 17.

Calligraphic Angle: Changing the angle of the line will change the
shape of the line much like when you draw with a Calligraphy pen.
Scale Stroke With Object: See page 17.

Bounding Box: See page 16.

Quick Customize: See page 7.

X [E] @ 2] &

Freehand Smoothing: See page 16.
Stroke Width: See page 17.

Scale Stroke With Object: See page 17.
Bounding Box: See page 16.

Quick Customize: See page 7.

Pressure Property Bar

Smart Drawing Tool Property Bar

Ao [£]| @ost [Z] oo 7] [E
Notes:

Shape Recognition Level: | Medium = Smart Smoothing Level:  Medium =

0.5 pt -

Shape Recognition Level: There are six levels that can be set to de-
tect the shape you draw with the tool.

Smart Smoothing Level: There are six levels of smoothing that can
be set before you draw the shape.

Outline Width: You can preselect or change the width of the outline.
Quick Customize: See page?7.

Vector Lettering Property Bar

The first part of the Property Bar is the same as for the Shapes Tools.

B s 2 Oo |0 g

w00 "
: 00"

~ | 24pt -

B I U E Ao ab]

Font List: Choose from all your True Type and Open Type installed
fonts on your computer.

Font Size: Size of the lettering, measured in points.

Bold/ Italics/ Underline: Underlining does not convert to embroidery
unless the lettering is first converted to curves.

Horizontal Alignment: Chose from None, Left, Center, Right, Full Jus-
tify, or Force Justify.

Bulleted List: This only works with Paragraph Text

Drop Cap: A large capital letter is added at the beginning of para-
graph text.

Text Properties: Opens the Text Properties docker window.

Edit Text: Opens a Text Editor dialog box to edit the text.

Quick Customize: See page 7.

2018 © BERNINA

Medium =

Mone
Lowest
Low
Medium
High
Highest

Artistic text is created by se-
lecting the Vector Lettering
tool and clicking on the draw-
ing page and typing.

Paragraph text is created by
selecting the Vector Lettering
tool and drawing a bounding
box; then typing.

The size of lettering is meas-
ured in points. 72 points
equals one inch.

Mone

Left

Center

Right

Full Justify

Force Justify

Page 19
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Reshape Property Bar
When a circular or rectangular shape is selected for reshape, the Property
Bar shows the same icons that are displayed when that shape is selected.

When a curve is selected, which can be a shape that has been converted
to curves or a shape drawn with the spiral tool or curve tools, a different set
of icons appear. These icons allow you to adjust the shape or the line in
many ways.

Rectangular n:, +": .,/u IF';\ g

Selection Mode: You can choose between Rectangular Selection
Mode and Freehand Selection Mode (like a lasso).

Add Node: You can add a node (reshape point) by right clicking on
the selected object after Reshape Vector Object is selected and select
Add. A node can also be added by clicking on the line where you wish to
add the node and then click on the Add Node icon. Double clicking on the
line in Reshape Mode will also add a node.

Delete Node: If you wish to delete a node, select the node and click
on the Delete Node icon or right click on the node and select Delete or se-
lect the node and press Delete.

Join Two Nodes: This icon will join aline by selecting the two end
nodes while holding the Shift key; then clicking on the icon.

Break Curve: This icon is used to break a closed object into an open
object at the selected node. Select the node, then click on the icon. You
can then move the nodes to separate the object.

Convert to Line: Converts a curved segment to a straight line.
Convert to Curve: To convert a line to curve, select the node and

click on this icon. A control handle appears at the node and you can click
and drag on the control handle to change the shape of the

OO0 W\aol.e,'fb mazz BERNINA

Notes:

\ \
| ’ -
1 I L

Join Nodes

\,
%, ] "-—h\\
-« N P TR -

~+“"" Break Gurve »

n u
Iﬂ' ﬁ
n u

Convert to Line

g
_:&/,.s—- $+ m\

o

Convert to Curve

line. |
Cusp Node: Creates a sharp angle at the node. Each ,ﬁ \
control handle can be moved independently of the other. c b
Think left click in digitizing. usp
Smooth Node: These nodes form a curve. The
control handles are opposite one another, butcan | = ... i
be different distances from the node. /.-—"'__r-_'-"=-7.;_:-h
Symmetrical Node: These nodes also form a I e
curve, but the control handles are an equal dis- Smooth ™.
tance from the node and give you a symmetrical =
curve.

¥ -- -
To change the type of node, select it and select the P ‘*—-:;_--f.
new type of node. ;_; Symmetri -::hﬁhm

2018 © BERNINA
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Reshape Property Bar Continued €C 2/ Notes:
Reverse Direction: Reverse Direction will change the start and end S ™ )
points of a line. - Reverse
Extract Sub-path: Extract a selected sub-path from an object, thus cre- Direction
ating two objects. " ol R
Extend Curve to Close: Joins the end nodes of a curve with a ..-/ e
straight line.
Close Curve: Close Curve joins the end nodes of a curve.
T 4
_______ , —T— — ( =
B @ o el -+ g % ReduceNodes R0 |4 Extend Curve to
_ Close
Sy
f N,
Stretch & Scale Nodes: This icon will add selection boxes around a — ~

selected node rather than around an entire object. The node can be
stretched either vertically or horizontally or scaled proportionately.

Rotate or Skew Nodes: This icon lets you rotate or skew a single
node, rather than an object. The corner arrows rotate; the horizontal ar-

| ]
Stretch & Scale Nodes

rows skew.

Align Nodes: By selecting two or more nodes with the Shift key and '\ Rotate Node
clicking on this icon, you can align nodes horizontally, vertically, or align

control points. A dialog box opens and you make your selection from the

dialog box.

Node Ali X
Reflect Nodes Horizontally: This icon lets you select two nodes and ey

mirror their positions as you move them. This reflection can be both hori- [v/] Align Horizontal
zontal and vertical if you have both icons active.

+| Align Vertical
Reflect Nodes Vertically fgn e :
+| Align Control Points
OK Cancel
Elastic Mode: This icon shapes a curve as though stretching an elas-
tic band.
Select All Nodes: Selects all nodes in an object. Reflect Nodes i+

Horizontally &
Vertically

Reduce Nodes: This icon increases the
smoothness of a curve by deleting nodes within
the selection. In Reshape, drag a bounding box
around the nodes; then click on the bar by the 0. ﬂ‘:'
This opens a slider bar. Click and drag the slider

bar to reduce the nodes.

’?
_u_

Bounding Box: See page 16.
Quick Customize: See page 7.
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tp Crop Tool Property Bar Notes:
X:[-3.0" ot 05"
0 =
Vi 2.625 " Tl025" 900 T

Crop Position: Use to reposition the crop.

Crop Size: Change the width or the height of the cropping area.
Angle of Rotation: Set the angle of the crop.

Clear Crop Marquee: Remove the crop area.

Quick Customize: See page 7.

n ] o
Two Point
r Knife Property Bar Line Mode
= [t 2| R0 [F]] 3 e
Freehand
. . . Mode
Two-Point Line Mode: Slice an object along a straight line. . n B
Freehand Mode: Slice an object along a freehand curve.
Bezier Mode: Slice an object along a Bezier curve.
Auto Close on Cut: Closes the path resulting from splitting an N Auto Close
object. ™ . on Cut
Freehand Smoothing: See page 16. L// .
Bounding Box: See page 16. . -
Quick Customize: See page 7. Bezier Mode
3 Segment Property Bar
rﬂ Shows the Eraser Tool Property Bar, but everything is
grayed out. . . —
, ”‘_\ p ,r _ \ .-'J II f b—
\\;_Frlll :L:\\| r X g |I ! I‘:'\j‘l _ ){u_/
VAN
S ~

i-‘ Eraser Tool Property Bar

shape (| []  &|025" S A |TA

Eraser Shape: A round or square eraser can be chosen.
Eraser Thickness: Changes the size of the Eraser Tool.
Pen Pressure: With digital pen or stylus, will vary the size of the

eraser with pressure.
Reduce Nodes: The number of nodes produced by erasing is kept to
a minimum when this icon is activated.

By clicking on an object after the Eraser Tool is selected; then moving to a
new location through the object and clicking again, a straight eraser line
will be drawn.

Holding the Ctrl key down as you drag will constrain the line to a certain
angle.
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Interactive Tool Property Bars Notes:
Blending Property Bar il ‘k
1 e
[i 9 perty Straight 8 Step
Wl -0.134 " Wi 1469 " Straight 10 Step
Presets... -
i L ¥: 0348 " I[1.396" Straight 20 Decel
Rotation 90 Degree
Presets: Choose from a drop-down selection of blend presets. Loop Blend
Object Origin: Used to set the reference point when scaling or mov- "
ing the object. [ enl06” J
Object Position: Position the object on the page using X and Y axis P .
values. "

Object Size: Set the width and the height of the object.

IL_CI.’ 20 et - - 8]
e mp|00 |2 [s=

e

Blend Steps: Change the number of steps between each object. Use
the up/down arrows or highlight the number, enter a new number and
press Enter.

Blend Spacih\g

Blend Spacing: Works with blends that have been fit to a path. Acti-
vate the blend spacing icon first; then type in a value
in the box.

Loop Blend

Blend Direction: Set the angle that the blend will
rotate between the two objects. Creates a spiral ef-
fect.

Blend
Direction

Loop Blend: This icon activates if you have

® changed the blend direction. The nodes of the two
blended objects form a curved path. The larger the
angle, the greater the curve of the path.

Path Properties: You can move the blend to
a new path, show the path, or detach the path

with this icon. Creating a new path is used when Show Path
you want to fit the blend to a drawn path.

Mew Path

E--*I Detach from Path

B e B W 7

The next three icons change the type of blend, which will change the color
appearance of the blend.

Counterclockwise

Direct Blend: Sets a direct color progression for the blend. The loop i

blend shown is a Direct Blend.

Clockwise Blend: Sets the color progression clockwise through the
color spectrum.

Counterclockwise Blend: Sets the color progression counterclock-
wise through the color spectrum.
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Blend Property Bar Continued Notes:
. A
|4--r:| 2 Acceleration:
o @6 % L H i
G
Object & Color T Color |

Object & Color Acceleration: Adjusts the
rate at which objects & colors appear in the
blend. The control starts in the middle and the
two can be locked to adjust together or un-
locked to be adjusted separately.

Size Acceleration: Adjusts the rate that the
size in the blend changes.

When the icon is activated, an arrow appears
on the blend that can be clicked and dragged
from one end to another of the blend.

Size Acceleration

More Blend Options:
Map Nodes: Select the blend; then click % Map nodes
on More Blend Options and select Map :
Nodes. Click on one of the nodes of the start | 'SPt
object and one of the nodes of the end ob-
ject to change the shape of the blend.

Split Blend: Select the blend; then click on More Blend
Options and select Split Nodes. Click on the intermediate ob-
ject where you want the blend to split. When that intermediate
object is moved, the blend changes shape.

Split Blend

Fuse Start: After a blend has been split, it can be
fused. Hold down the Ctrl key and click a middle ob-
ject in a blend; then click a start or end object. If you % Fuseend
selected the start object, click on Fuse Start; if you
selected the end object, click on Fuse End.

Blend Along Full Path: If a blend has been Blend along full path

fit to a path, you can click on Blend Along Full i

Path to extend the blend over the entire path. b s i

Rotate All Objects: Rotates the objects that have been fit to a path. Starting & Ending

Objects

Starting & Ending Objects: This icon will let you change the start or
the end of a blend by clicking on an object outside the blend that you want to
use as a new start or end.
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Blend Property Bar Continued Notes:

O

Gy By

Copy Blend Properties: When two blends have been created, the
Copy Blend Properties becomes highlighted. Select the blend you wish to
change; click on the icon; then click the on the blend you want to copy.
This does not affect the colors or shapes in the blend, only the number of
steps in a blend.

Clear Blend: Removes the blend from the two objects.
Quick Customize: See page 7.

O] Contour Property Bar Presets... -
Flow lnward
¥l -13.460" W 2 702 " Flow Qutward
it T v:[3.423" i 2.625" '

Presets: You can choose between two preset options for the
contour—flow inward and flow outward.

Add Preset: Save the current settings as preset.

Delete Preset: Remove the selected preset from the list.

Object Origin: Set the reference point for positioning or scaling
objects.

Object Position: Position the object on the X and Y axis.
Object Size: Set the width or height of the object.

Placement of Contour:

To Center: This icon applies a contour that fills the object.

Inside Contour: This icon applies a contour to the inside of an object.
Outside Contour: This icon applies a contour to the outside of an ob-

If you receive an error mes-
sage that the Offset is too

) large, you can adjust the size
ject. of the offset or the type of con-

tour.

To Center To Inside
To QOutside
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Contour Property Bar Continued Notes:

o | EL IET; .-

Contour Steps: This icon adjusts the number of steps in the con-
tour.

Contour Offset: This icon adjusts the spacing between the con-

tours of the object. CorelDRAW SE X
Contour Corners: Choose between mitered, round, and beveled e Conte sttt
corners.

If you receive an error mes-
sage that the Offset is too
large, you can adjust the size
of the offset or the type of con-
Contour Colors: Sets a color progression through the color spec- tour.

trum—linear, clockwise, or counterclockwise.

@T‘ Linear Contour Colors
@‘ Clockwise Contour Colors

r@ Counterclockwise Contour Colors

Linear Clockwise Counterclockwise

(- <o~ [ G

Outline Color: Choose the outline color for the contour. ¢ Oultine e =] Fil

Fill Color: Choose the fill color for the contour.
Last Fill Color: Choose the second color of the fill.
Object & Color Acceleration: Adjusts the rate that the size and color

change within the contour. They can be adjusted together or independently
by unlocking the lock.

Copy Contour Properties: Apply the contour properties of another <
contour object to the selected contour object. This will apply the steps and Acceleration:

offset, but not the color. [ obiect ————
Clear Contour: Removes the contour from the object. 1y
Quick Customize: See page 7. nColor: N
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' Distort Property Bar — 7] | Notes:
Pt - + Pull Cormers PRESETS
Push Corners d
Twister
Preset Selection: You can choose among five types Stamp Pull Comers
of preset distortions—pull corners, push corners, twister, B
stamp, and zipper. Each selection will change the property —
bar icons slightly. These changes will be covered on the next page.

After selecting the Distort icon, clicking on the object, and selecting a Pre- Push: Comers

set, the object is distorted. After the object is distorted, a reshape control
lets you adjust the object if desired.

Twister

O

kﬁ o .

Zipper

Add Preset: Save the current object settings as a preset.
Remove Preset: Remove the selected preset from the list. %

Distortion Icons: ol i Y &

You may use the next icons to manually distort an object. Select the object,
select the icon, then click and drag on the control. When you release, the
object will be distorted. There is a reshape control so you can make addi-
tional adjustments. Push-Pull

Push-Pull Distortion: Distort the object by pushing in and pulling out.

Zipper Distortion: Apply a saw tooth edge to the object. O’
Twister Distortion: Rotate the object to apply a swirl effect.

Zipper

Center Distortion: Object is distorted from center out.

Common Icons at End of Property Bar d@RC .
Add New Distortion: Adds a second distortion to the distorted object. L
Copy Distortion Properties: Apply the distortion properties of anoth- Twister

er distorted object to the selected object. Select the object to be distorted,

click on Distort, click on Copy, click on distorted source object and the se-
lected object will be distorted. A
Clear Distortion: Removes the distortion.

Convert to Curves: Allows the object to be modified using Reshape. bl
Quick Customize: See page 7.
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Distort Property Bar Continued : Notes:

When either a preset is selected or one of the Distort icons, the Prop--
erty bar will look slightly different. {

Push Pull Amplitude: Adjusts the inflation or deflation of
the object. This can be adjusted numerically or with the control

handles. %
Amplitade
This icon will appear for Presets of Push Corners or Pull Cor-
ners, and also for the Push-Pull Distortion icon.
Zipper . Base
MO D] v [T R
Zipper
Amplitude
Zipper Amplitude: Adjusts the height of the teeth in the sawtooth ef-
fect.
Zipper Frequency: Adjust the number of teeth in the sawtooth effect. .
Random Distortion: Makes the effects in the distortion random. Fé"’u”:':
Smooth Distortion: Smooths the nodes in the distortion. s
Localize Distortion: Reduces the effects as the distortion progresses.
These icons will appear when either the Zipper preset is selected or the
Zipper icon. They also appear when Stamp preset is selected.
Twister O Qe B o |
These first directional icons apply the direction of rotation: o
Clockwise Rotation: Apply a clockwise distortion. R e
Counterclockwise Rotation: Apply a counterclockwise distortion.
Complete Rotations: Sets the number of complete rotations for a dis-
tortion. Coumerclr;_)ckwise
Additional Degrees: Set the number of degrees beyond a complete Rotation
rotation.
These icons appear with either the Twister preset or the
Twister icon.
& Increased Increased
ase number degrees
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Envelope Property Bar

Envelopes will let you shape objects and text to a particular shape. You
can also edit these shapes. The first icons in the property bar should look
familiar to some of the Reshape icons.

presets.. + + 228N~ o~

Rectangular =

Presets: Like other Interactive Tools, you can choose among a list of
presets. You can also save a preset or remove a preset.
Selection Mode: Choose between Rectangular or Freehand.

Add Nodes
Presets... 1i -I-
Circular

Delete Nodes

Convert to Line

Convert to Curve

Cusp Node Rectilinear
Smooth Node
Symmetrical Node

Rectilinear Slant

Notes:

. Circular

Pinch

Push Down
The rest of the Envelope Property Bar looks like this: Push Up
Al d|jpay  ~ 52 B Bg#® G

Unconstrained Mode: Apply a freeform envelope that allows changes
to the node properties.

Straight Line Mode: Applies an envelope of straight lines.

Single Arc Mode: Apply an envelope to produce an arc shape.
Double Arc Mode: Apply an envelope to produce an S shape.

Mapping Mode: Choose how the object fits within the

Putty YH
envelope. —

Unconstrained
Mode

There are four choices of modes. Horizontal
Original
, . . | Putty
Keep Lines: Preserves straight lines when applying Nchical
an envelope.

Add New Envelope: Apply a new envelope to an object that already
has an envelope.
Create Envelope From: Create an envelope based on the shape of

another one.

Single Arc
Mode

Straight Line
Mode

Copy Envelope Properties: When two envelopes are present, you can
copy the envelope properties from one envelope to the other.
Clear Envelope: Clear the envelope from the object.

Convert to Curves: Allows the object to be modified using the Re-

shape.
Quick Customize: See page 7.
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Extrude Property Bar

Extrusions make objects appear three-dimensional. Most
of these effects are for printing and not for embroidery.

Presets... -

x|9.458"
e -0.603 "

Extrude Presets: There are six extrude presets.

Add Preset
Delete Preset
Object Origin

Object Position: Shows the position

of the extruded object.

Notes:

Extrude Top Left
Extrude Top

Extrude Top Right
Extrude Bottorn Right

Extrude Top Left

Extrude Top

Extrude Top Right

Extrude Bottom
Extrude Bottom Left

)

Extrude Bottom Right

2

Extrude Bottom

Extrude Boltom
Lefi

o L] 376"

& -9.5027 = |VP Locked To Object ~ g2 ‘8 | °
¥ TS = =

Extrusion Type: Choose among six extrusion types to apply

In| Bl

to an object.

Vanishing Point Coordinates: You can set the X & Y coordi-
nates for the vanishing point that creates the perspective.
Vanishing Point Properties: Select different ways to set the

ZCN

Increasing
Depth

LY.
)

LY

4
~

vanishing point.

Page or Object Vanishing Point: Locks the location of the
vanishing point to a page or object.

Depth: Adjusts the depth of the extrusion for the object.

R, @&, @ & e

Extrude Rotation: Lets you visually rotate the extruded object to
change the vanishing point.

Extrusion Color: Lets you apply a uniform color to the entire object
or a contrast solid color to the extrusion or a shaded color to the extrusion.
Extrusion Bevels: Adds sloped bevels to the extrusion.

Extrusion Lighting: You can change the position of lighting effects.
Copy Properties of Extrusion: With two extruded objects, you can
copy the properties of one to another.

Clear Extrusion: Clears the extrusion from the object.

Quick Customize: See page 7.

Extrude Rotation

Extrusion Color Extrusion Bevels

2018 © BERNINA
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b Interactive Fill Property Bar Notes:

When you select the Interactive Fill Property bar, the icons shown below
appear. These fills, other than uniform fills, are for printing and will not
translate to embroidery.

X 4B HFEL M- B &

No Fill: Removes the fill.
Uniform Fill: Applies a solid color fill.
Fountain Fill: Applies a gradient of colors or shades.
Vector Pattern Fill: Applies a vector pattern.
Bitmap Pattern Fill: Applies a bitmap pattern.
Two-Color Pattern Fill: Applies two colors.
Fill Color: Choose afill color from the drop-down dialog box.
Copy Fill: Apply the properties of one fill to the selected object.
Edit Fill icon: Opens the dialog box to edit the fill.
E You can also open the Edit dialog boxes by clicking on the Fill icon in the

first column of tools and clicking on the corresponding fill you want to edit.
Quick Customize: See page 7.

Uniform Fills:
When you edit a uniform fill, you are selecting from among several color
palette choices.

Fountain Fills:

The Fountain Fill is a smooth progression of two or more colors. These
types of fills are also known as gradient fills. There are four types of Foun- ;

tain fills: linear, elliptical, conical, and rectangular. Fountain

Fill

s S

Fill Picker: Choose afill from alibrary.

Linear: Color changes over a linear path.

Elliptical: Color changes from center out in an elliptical pattern.
Conical: Color changes in a conical shape.

Rectangular: Color changes in a rectangular pattern.

' Linear Elliptical Conical Rectangular

2018 © BERNINA ' Page 31
DL



O

OO0 madﬂ,"’b maE BEHNINA

Fountain Fills Cont.:

(O~ Bow [4] o 0x%:| G B, B oo |4 [E
Node Color: Specify the color of a selected node.
Node Transparency: Specify the transparency
of the selected node. Click on the icon; then drag 100 %

the slider bar.

Node Position: Specify the position of an inter- |7 ! | .{L

mediate node.

Reverse Fill: Flip the fountain fill.
Arrangement: Mirror or repeat the fountain fill.
Smooth: Creates a smoother color transition.
Acceleration: Affects how quickly the object blends. Click on the
icon; then drag the slider bar.

Free scale & skew: Allows fill to look skewed or stretched dispropor-
tionately.

Adding Colors

To add a third color to the Fountain
Fill, click and drag on a color chip
to the slotted bar on the dotted
line.

Repeat to add more colors.

Vector Pattern Fills

Fill Picker: Choose afill from a public or personal library. Double
click on the one you wish to use.

Mirror Tiles Horizontally: Alternating tiles are horizontal reflec-
tions.

Mirror Tiles Vertically: Alternating tiles are vertical reflections of
each other.

Transform with Objects: You can skew the orientation of the pat-
tern or edit the size by making changes to the
object shape that appears when the object is
selected.

Reshape Fill:
You can also use the control points within the
fill to move the fill within the object.

.-~ 'Reshape Fill

2018 © BERNINA

Notes:

Ty

Node
Color

Reverse Fill

o

Repeat & Mirror

N

Mirror Tiles Horizontally
Mirror Tiles Vertically
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Bitmap Pattern Fill Notes:

BB -~ s -2 Blend Transition = 7

Fill Picker: Use to select a bitmap fill. Double click to download the
fill.

Mirror Tiles Horizontally

Mirror Tiles Vertically

Blend Transition: Adjust the color and edge transitions of the pattern
fills.

Transform with Object

Two Color Pattern Fills

o | |B|-|O]~ s & |

First Fill Color or Pattern: Pick the first color or pattern.
Front Color: Choose aforeground color for the pattern.
Back Color: Choose a background color for the pattern.
Mirror Tiles Horizontally

Mirror Tiles Vertically

Transform with Object: See page 32.

. . B ] Two-color Pattern Fill
Two other fill types can be accessed by clicking on the drop-down arrow by

the Two Color Pattern Fill icon. Texture Fill
A5 PostScript Fill

Texture Fills

3] | Samples7 -+ - [} sp 2. o
.‘ - o ! ] .

Texture Library: Choose a folder of samples.

Fill Picker: Choose your texture.

Texture Options: Modify the texture options, such as resolution and
maximum tile width.

Mirror Tiles Horizontally

Mirror Tiles Vertically

Transform with Object: See page 32.

PostScript Fill
SpiderWeb = %

PostScript Textures: Choose a texture category. Use the Edit Fill dia-
log box to access ways to edit these fills. Open the dialog box by going to
the Fill icon and selecting the Texture Fill icon.

%
3

£
o
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Shadow Tool Property Bars

] T
-+ 00"

Presets...

S [+ @[ [+ @

[#

Drop shadows simulate light
falling on an object.

Preset List: Choose from the Preset options shown below.
The Presets will automatically adjust the angle of the shadow, but you can
change the angle if you wish by dragging the arrow when the object is se-

Presets..,

Flat Top Right

Flat Bottom Right

Flat Bottormn Left

Flat Top Left

Perspective Top Right
Perspective Bottorn Right
Perspective Bottom Left
Perspective Top Left
Small Glow

Medium Glow

Large Glow

lected.
Add Preset
Delete Preset
Flat Perspective Glow
Top right Small
Topright e fium
Bottom right Boitom right
Bottpm lefi|
Bottom left
Large

Drop Shadow Offset: This sets the distance between the object and

the drop shadow.

Drop Shadow Angle: Sets the direction of the drop shadow.
Shadow Stretch: Adjusts the length of the drop shadow.
Shadow Fade: Adjusts the amount of fading at the edge of the drop

shadow.

2018 © BERNINA

Shadow Angle

Drop Shadow Offset

Shadow Stretch

Shadow Fade
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Drop Shadow cont. Notes:
ER(50 |+ # |15 |+ Bl - Muttiply - o
Opacity p
Drop Shadow Opacity: Adjust the transparency of the drop i .
shadow. D’*%b
For Opacity, the lower the number, the lighter the shadow.
Shadow Feathering: Sharpen or soften the edges of the i
shadow. F|
For Feathering, the higher the number the more disperse the —
shadow. IZIX
Feathering
;| -
Drop Shadow Feathering Direction: This icon will open a list of Insid
choices and will determine where the shadow is softened. i
[Z)] Middle
Outzide
@ Average
B I Multiply wﬂ
Feather Edge: This icon chooses the feathering Oy Linear Mormal
style. 0 Add
= Squared Subtract
ELI‘__,U Inverse Squared | | pitference
Cf Flat Multiply
Divide
If Lighter
Shadow Color: Choose the color of the shadow. If Darker
Texturize
) Color
Merge Mode: Choose how the color of the shadow blends with the |4,
underlying object. There is a long list to experiment with! i
Lightness
.-:'? Inwvert
Lagical AMD
Copy Shadow Properties: Apply the drop shadow properties of an-  [Logical OR
other object to the selected object. Logical XOR
Behind
Clear Drop Shadow: Remove the drop shadow from the object. e
. . Owerlay
Quick Customize: See page 7. Soft Light
Hard Light
Color Dodge
2018 © BERNINA Coler Burn Page 35
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Transparency Property Bar

When you apply transparencies to an object, objects beneath it become
visible.

B WEEEE Nom -

No Transparency: Remove the transparency.

Uniform Transparency: Apply a regular and even transparency.
Fountain Transparency: Apply a gradient transparency.

Vector Pattern Transparency: Apply a vector pattern transparency.
Bitmap Pattern Transparency: Apply a bitmap pattern transparency.
Two Color Transparency: Apply atwo color transparency.

Texture Transparency: Access this by clicking on the triangle in the
corner of the Two Color Transparency.

m
ency

ntain
arency

After selecting the type of transparency, the Property Bar will change.
Some icons do remain consistent in the Property bar.

Common icons:

AN + B H

Marmal -

Merge Mode: Choose how the transparency merges with the object.
There are numerous choices.

All: Apply the transparency to both the fill and the outline.

Fill: Apply the transparency to only the fill.

Outline: Apply the transparency to only the outline.

Freeze Transparency: Freeze the current view of the transparency so
it doesn’t change when the object is moved.

Copy Transparency: Apply the transparency properties of one trans-
parent object to the selected object.

Edit Transparency: Change the properties of the transparency. This
opens a dialog box.

Quick Customize: See page 7.

2018 © BERNINA

Notes:

Marmal

Marmal

Add
Subtract
Difference
Multiply
Divide

If Lighter

If Darker
Tesxturize
Color

Hue
Saturaticon
Lightness
Invert
Logical AMD
Logical OR
Lagical XOR
Behind
Screen
Overlay
Soft Light
Hard Light
Color Dodge

Color Burn

Exclusion
Red
Green
Blue
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Uniform Transparency Notes:

B

Transparency Picker: Choose a preset transparency.
Transparency: Adjust the level of transparency. Higher values
make the color more transparent.

ncy

Fountain Transparency

E- BEBEHEHB Bo +% -0 0.0° = :
Linear
Transparency Picker: Choose a transparency.
Linear Fountain Transparency: Transparency changes along a
linear path.
Elliptical Fountain Transparency: Transparency changes along LA
concentric ellipses from the center. Elliptical

Conical Fountain Transparency: Transparency changes in a
conical shape. .
Rectangular Fountain Transparency: Transparency changes in
a rectangle from center out.

Node Transparency: Specify the transparency of the selected
node.

Node Position: Specify the position of an intermediate node
between the first and the last nodes.

Rotate: Rotate the transparency to a specific angle. -__J

Rectangular

Conical

Free Scale & Skew: Stretch or skew the transparency.

Vector Pattern Transparency

B~ 00 & -0 L

Transparency Picker: Choose atransparency.

Foreground Transparency: Set the opacity of the foreground
color.

Background Transparency: Set the opacity of the background
color.

Mirror Tiles Horizontally: Alternating tiles are horizontal reflec-
tions of one another.

Mirror Tiles Vertically: Alternating tiles are vertical reflections
of one another.
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Notes:

Bitmap Pattern Transparency
B o &7 -0 [+

This Property Bar has the same icons as the Vector Pattern Trans-
parency Bar, but there is one additional icon.

Blend Transition -

Seamless: § 30 %

Blend Transition: Adjusts the edge and color of the pattern Edge match: 50
tiles.
Brightness: 0

Luminance: 0

Color: |0

Two Color Transparency

mmmo=i vy 0 || 036 |+
Transparency Picker: Choose a transparency. it
Foreground Transparency: Set the opacity of the foreground iam‘véﬁ
color. 8 )
Background Transparency: Set the opacity of the back- B
ground color. g e

Texture Transparency

Samples = gﬁ' I~ | 100 + o =10 +

Texture Library: Choose alibrary.

Transparency Picker: Choose a transparency.
Foreground Transparency: Set the transparency of the
foreground.

Background Transparency: Set the transparency of the
background.
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/ Eyedropper/Bucket Property Bar Notes:

y’ Q Select from Desktop _f .P’ f Selected color - Add To Palette -

Select Color: Select a color from the document window.
Apply Color: Apply the selected color to an object.

Sample from Desktop: Sample a color from outside the soft-
ware.

1 x1: Sample the color of a single pixel.
2 x 2: Sample the average color value in a2 x 2 area.
5 x 5: Sample the average color valuein a5 x 5 area.

Selected Color: Shows the selected color.
Add to Palette: Choose the color palette for the selected color.
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COREL SE ADDITIONAL TOOLS Notes:
By right clicking on the Property Bar in Art- | + MenuBar k , Pick tool
work Canvas and placing a check mark by | « Status Bar
Toolbox, you can open the Corel SE toolbar | , .14z tv, Shape Tool
in Artwork Canvas and additional Corel ; ] Crob Tool
tools can be accessed. B - eapety P
. |J Toolbox Zoom Tool
The tools that are the same as those in Art- Zoom k
work Canvas will not be covered here. % Drawing Tools
Please review the previous pages for an
explanation of what these tools do. =t Artistic Media Tool
Print Merge
The most useful tools are explained below. Mo Rectangle Tools
Internet Ellipse Tools
B Tk Toalhae Polygon Tool + Misc Shapes

T Tool
DRAWING TOOLS ext Too

These are the additional drawing tools found in Corel SE. They
are accessed by clicking on the visible drawing tool in the toolbar
and dragging to select the new tool.

Dimension Tools

Connector Tools

2-Point Line: Interactive Tools
n/n This tool will draw a line between two points. Click and drag to place

the line. When you release the mouse, the line will be complete.

BU /N 20007 O

Transparency Tool

Bezier Tool: 2 Color Eyedropper Tool
_)n’ To draw a straight line with the Bezier tool, click, release the mouse, 4
drag and click again. @j‘ Interactive Fill Tool

To get a curved line, click and drag. Control handles will appear which | € Smart Fill
can be used to shape the curve.

To finish the line, press the space bar.

B-Spline Tool

?\m Three points are drawn with this tool. The first click sets the origin of
the line; the second click sets the curve; and the third will set the next
curve. When you want to end the line, double click.

Polyline Tool
é The Polyline tool works like the Pen tool in Artwork Canvas, but the line G

continues when you let go of the mouse. Double click to end the line. \Q»%
Three Point Curve Tool 6,_’

Click and drag to draw the length of the line; then choose a point for

height and the angle of the line by dragging the mouse. Clicking to set T T
A% the curve will end the line.
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ADDITIONAL SHAPES TOOLS
There are additional shape tools found in Corel SE. These are
combined with the Rectangle, Ellipse, or Polygon tools.

3-Point Rectangle:

This tool will draw a rectangle. It is useful for drawing a rectangle at
an angle. Click and drag to draw one dimension of the rectangle,
release the mouse to draw the other dimension. Click to end the
shape.

3-Point Ellipse:

This tool will draw an oval. It is useful for drawing an oval at an an-
gle. Click and drag to draw one dimension of the oval, release the
mouse to draw the other dimension. Click to end the shape.

Complex Star

This tool is found with the Polygon tool. Click and drag to draw the
size of the star desired. As with other shapes tools, holding the Ctrl
key draws an equal sided star. The number of sides or points can
be adjusted in the Property Bar. The Sharpness can also be adjust-
ed.

SMART FILL

At the bottom of the Corel SE Toolbar, you will find the Smart
Fill tool. It is useful for adding colors to shapes that are divided
with lines.

For example, if you draw a complex star, each of the areas
can have a different color added to it.

After drawing the shape, select Smart Fill and click on each
section of the star. This adds the same color to each individual
section.

To fill the area with different colors, go to the Color Palette,
and click and drag the color to the star.

This effect converts to embroidery.
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DOCKERS | Notes:

v | Object Properties Alt+Enter
Dockers are found on the right side of the design screen. At the right, | s Object Manager

you will see a list of all the dockers that can be opened in Corel-
DRAW SE.

O

Ohbject Data Manager
Object Styles Ctrl+F5

Dockers provide quick access to editing functions that are
available through icons or dialog boxes that open in the soft- i

ware.

Object Coordinates
Symbol Manager Ctrl+F3

E il
s

S

- . Alignment and Dynamic Guides
To make the docker visible, go to Window> Dockers and
place a check mark by those that you wish to have available.
Only one docker will show at a time. The rest will show as
tabs along the side of the Docker Window.

Transformations [
Align and Distribute  Ctrl+Shift+A
Step and Repeat Ctrl+Shift+D
Shaping

Fillet/Scallop/Chamfer

saipadolg algp @

Join Curves

Effects L
Text ]
Color

Color Proof Settings

Color Palette Manager

Color Styles Ctrl+Fé

sabeuey 3aalgg M

Get More

Tray
v | Hints
Internet

Links and Bookmarks

Undeo Manager

Macro Manager Alt+Shift+F11

This concludes the tour of Artwork Canvas. This is only a beginning guide
to understanding this powerful part of our BERNINA Embroidery Software.
It is necessary to first understand the tools available along with a brief idea
of what the different tools do. Don’t be afraid to jump in and play and dis-
cover what else can be created!
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